
Laser-Induced Breakdown Spectroscopy (LIBS) System
(Operation Procedure) 
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Disclaimer
Safety – first !!! This presentation is not manual. It is 
just a brief set of rules to remind procedure for 
simple measurements. You should read manual first 
and follow all requirement for operation with 
electrical and laser devices 

Context
1. Introduction 

2. Switch On Procedure

3. Sample Placing

4. CCD Camera Calibration (Outer image alignment)

5. LUCi (Litron Universal Controller) quick overview

6. Starting measurements

7. Stop measurements

8. Spectral Lines Database (Elemental analysis)

9. Saving Data

10. Shutting down the system
Appendix
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Introduction 
What is LIBS

Laser-induced breakdown spectroscopy (LIBS) 
is a straightforward and versatile spectroscopic 
technique based on the analysis of the spectral 
emission from laser-induced plasmas. 
LIBS has the far-reaching capability to provide 
rapid, in situ multielement detection of any 
material – solid, liquid, or gas. The field of LIBS 
has been rapidly maturing as a consequence of 
interest in LIBS for a broad spectrum of 
applications and the recent development of 
LIBS analytical systems by the commercial 
sector. 

RS Harmon, RE Russo
Laser-Induced Breakdown Spectroscopy
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Introduction 
Experimental Setup

PC + Sophi software control 
settings and measured data 

LIBSpector Chamber (enclosure) 
with built-in laser head 

Laser Power 
Supply

Laser Remote 
(LUCi) Controller

LIBS Controller manages 
electrical triggering pulses 
between LIBS components   

Stage Joystick controls 
position of the sample in 
the LIBS chamber  

Echelle spectrometer and attached 
CCD camera measure emission 
spectra of the ablated plasma. 
Spectrometer is connected to the 
LIBS chamber and Calibration lamp 
by Optical Fibers

Laser control units 

XYZ Translational Stage
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Introduction
Technical Specification

Echelle spectrograph :
 Aperture: f/10
 Focal length: 200 mm
 Slit width: 40 μm
 Wavelength range: 200 to 750 nm 

(max 600 nm simultaneous)
 Spectral resolving power: 7,000-

15000
 Spectral resolution FWHM: 22 to 

83 pm
 Absolute accuracy: spectral 

resolution / 4
 Order crosstalk: 2 x 10-3 (CCD) 

measured at 253.652 nm and full 
slit height

Detector (Andor iStar): 
Model DH334T-18F-03-27A
ICCD 1,024 x 1,024 pixels, 
13 x 13 µm2 image area, 
Minimum optical gate width, 5ns. 
Dynamic range: 15 bit, 
SN ICCD-60447; Y 2021

Litron Laser Nano 120-20 : 
Wavelength 1064 nm
Output energy 120mJ
Repetition 20Hz
Pulse Duration 4-7 ns
SN LM3089;  Y 2020



Step 0: 

• Check all connections according to the scheme shown 
in the Appendix. 

• Switch ON LIBS Computer

• Run .txt file ”LIBS Operation Sheets” with 
operation records and fill in your name, date and time 
of experiment 

• Also make the same note in the operation notebook 
near LIBS System

Switch On Procedure 
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Step 1 (Switch On Litron Laser): 

On the back side of the Laser Power Supply Unit,
check the coolant level using glass window. Water 
level must be higher than minimum coolant level.

Step 2 (Switch On Litron Laser):

Right above the glass window, still on the back side 
of the Laser Power Supply Unit, turn ON Power 
Switch.

Step 3 (Switch On Litron Laser):

Holding the lock by its base, turn the key on the 
front panel of Laser Power Supply Unit to position 
ON. Look at the system indicator situated on the left 
of the key you turned.

Switch On Procedure 

Note: Check status of all activated 
systems on LUCi controller
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Step 4 (Switch On LIBS CHAMBER UNIT):

Turn on Light and Pilot Laser switches on the front 
panel of LIBS CHAMBER UNIT.

Step 5 (Switch On ICCD camera):

Push the red button on the back panel of ICCD
camera to On position. You will hear the fan start to 
work.

Step 6 (Switch On LIBS Controller):

Turn On main switch on the front panel of LIBS 
Controller.

Switch On Procedure 
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Step 6 (Run Sophi Software): 

Start the Sophi program on the desktop of 
the PC. Check the indicators in the left 
lower part. If everything is fine, you will 
see three active indicators: Camera, LIBS 
control and Spectrometer. 

• At first Camera status will be yellow.

• You must wait for 3-5 minutes until 
camera has cooled down enough. The 
indicator will automatically change its 
color to green.

Note: Choper, Laser and Energymeter indicators 
should not show anything. In our setup we don’t 
have them integrated.

• When system is ready, all three 
indicators must be green.

Switch On Procedure 
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Step 7 (initialize the motorized sample stage in the LIBS Chamber ):

• Now we need to initialize the stage in the Sophi software. To do so, 
in the upper part of the screen in the second row below the settings 
find the XYZ-Axis symbol.

• It opens LTB Stage client. Here in the upper left corner, we have 
home button (blue house sign). Press it and the stage should now 
move to its “home” position on the lower left part of the chamber. 
Wait until it stops.

• Now stage is initialized, and we can control it with joystick.

XYZ-Axis 
symbol

Home button

Switch On Procedure 
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Step 8(Focusing laser I):

• Put sample inside LIBSpector chamber on translational stage 

• Look inside the LIBSpector chamber. Two red dots inside should be visible. Sample surface is in 
focus when these two dots covering each other. 

• Move the joystick to control position of stage with sample, rotate joystick to control its height. 
You have to make them covering so that you could only see one bright dot on the sample.

• Close chamber

Focusing

Sample Placing
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Step 8 (Focusing laser II, built in Camera)

1. Once you have your sample 
inside no need to open the hood of 
LIBS and look at the red dots for 
focusing. We have a built in
camera to help us focus and move 
to a next spot.
2. Open Image mapping option 
can be easily used to focus the 
pilot laser onto the sample.

3. On the right a defocused laser 
consisting two dots is visible.
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Step 8 (Focusing laser II, built In Camera and its usage)

4. Use the joystick to move the laser dots so that 
they keep coming closer and form one red dot.

5. When you have a focused laser light 
illuminating the sample it should look like this.

6. Saving the picture option does not work, 
instead use snipe to copy the image and paste it 
where you want to be.

7. Using joystick each time find a new and fresh 
spot for data collection. 

8. There is a time delay between the joystick and 
laser light moving. Move the joystick slowly for 
correct position.



This procedure could be done periodically during measurements:

Important: Outer image alignment needed to be done every day 
before starting measurements of samples. 

• To find this option in Sophi software on the left upper corner go to 
Settings ⇒ Options ⇒ Spectrometer ⇒ Outer image alignment.    
CCD camera will be calibrated automatically.

• After calibration is done Sophie will show you offset values.

• Note for unstable lab conditions: If intensive fluctuations of air or 
temperature changes take place in lab, you might need to do outer 
image alignment every hour to make sure system works precisely.

After Calibration Procedure, the LIBS system is ready to work 

CCD Camera Calibration (Outer image alignment)
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The LUCi control box can be used to operate a selection of 
Litron laser systems. It automatically detects the laser model 
and presents a number of control screens with which you can 
control and monitor the system. 

• This screen displays the state of the individual laser 
interlocks. 

• If the laser trips out, this screen will show the interlock 
which caused the laser to turn off

• RED indicates a fault condition. Green indicates OK.

• It is usual for some interlocks to be shown in RED until the 
laser is powered on. If the laser will not power on, the 
interlock indicators will help diagnose the probable cause

LUCi (Litron Universal Controller) quick overview
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Note: Laser Repetition rate in SOPHI and LUCi must be same value otherwise in LUCi “Shutter Inhibited” will appear 
instead of stutter closed and immediately the system will stop working. 
To change repetition rate- first change value in LUCi then change the value in SOPHI.



• Under big green button on the left side of the screen choose Parameters ⇒
Type of measurement ⇒ LibsExperiment

• Here you have to set up parameters you need. 

 Averaging – number of measurements system will average in one 
spectrum.

 Number of shots – number of laser shots system will made in one 
measurement.

 Laser repetition rate – frequency of shots in one measurement.

 Delay time – time between laser shot and CCD camera shot of spectrum.

 CCD Clock – frequency of CCD camera. (CCD camera read time for one 
whole measurement, not just for one shot)

 ICCD settings – in progress, no info yet.

Note: There is also continuous measurement checkbox. If this option is activated 
system will continue measuring until you stop it by yourself. 

Important: Camera saturation not more than 180000-200000 intensity on 
spectrum.

Starting measurements
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After all the parameters are set up, we are ready to start the laser:

• On LUCi controller press big LASER button

Note: You will hear the water pump. In the left lower corner of 
LUCi screen you will see the timer. Wait until it will allow you 
activate the laser. You will hear the flashlamp noise.

• Open the shutter with green button SHUTTER OPEN

• In Sophie press green start button

• Now LIBS starts measurement.

Starting measurements
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After measurement is done there are two options:

• Close the shutter with red close shutter button

• Then press LASER button on the LUCi screen. This will 
stop flashlamp. Water pump will continue working.

OR

• Just press STOP on LUCi. (same thing but in one step)

Note: If you are not completely done yet, do not turn off the 
water pump

• To turn off the water pump, press STOP on LUCi again.

If you open the chamber, laser stops automatically.

Stop measurements
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Sophi has integrated NIST databases for spectral lines. So you can make 
elemental analysis within Sophi software.

• On the left upper corner in Sophi activate elemental analysis

• On spectrum holding the left mouse button choose the area you want 
to analyse.

• Sophi will zoom to this area and show you what lines it has identified 
from NIST database. Also on the left side of the screen you will see 
the column with all identified elements in spectrum.

• To return to full picture of spectrum use blue zoom buttons in Sophi.

Spectral lines database (elemental analysis within Sophi)
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After measurement is done, you will see obtained spectrum in Sophi.

• To save the spectrum in .ary format in left upper corner in Sophi
File ⇒ Save ⇒ Choose folder to save file. 

Note: Every student must create their own folder named with last 
name of the student.

Note: .ary file can be opened again in Sophie for analysis.

• To save the spectrum in .txt (or other formats, but .xls currently 
not working) File ⇒ Export ⇒ .txt (or others) ⇒ Choose folder.

Saving data.
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Step 1
After you finished working with LIBS system you have 
to switch the whole system off.

• Make sure shutter is closed (look at the LUCi) and 
laser is stopped. No flashlamp noise. (page 15)

• Make sure the water pump is turned off. (page 15)

• Close Sophi software. (Just X in right upper corner)

• Turn the CCD camera off, red button on its back 
panel

• Turn off Light and Pilot Laser switches on the front 
panel of LIBS CHAMBER UNIT.

• Turn the key on POWER SUPPLY to OFF position.

• Switch off the POWER SUPPLY on its back panel

Shutting down the system.
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Step 2
• Turn the key on POWER SUPPLY to OFF 

position.

• Switch off the POWER SUPPLY on its back panel

• Turn off the PC (additionally)

Now system switched off completely.

Shutting down the system.

22



Lamp  /Ex 
trigger

NA

Appendix 1
LIB Spectra Connections I 

PC
USB Ports

LUCi Remote 
Controller

Power 
Cable
~110v

COOLANT 
FLOW and  

RETURN

To laser Head Installed in 
LIBS Housing  ?

Laser 
Head

Interlock

To laser Head Installed in 
LIBS Housing 

RS232 ( DB25)

Bundle from Laser Driver

Observation 
Camera

RS484 IN

DC Power Supply
24V 3.74A

NA NA

Joystick

To spectrometer 
SMA fiber

PSU Back Panel

Q-switch /DA

PSU Front Panel

To LIBS controller

LIBS Housing Back Panel
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PC
USB Ports

Spectrometer +CCD 
Back Panel

Dongle 
ID 

USB

DC Power Supply
12V 

USB

I2C  

LIBS Controller Front Panel 

Sutter

Sutter

~110V

Trigger ICCD
EXT Trigger

Flash Lamp

Q-switch
Lamp  /ext rigger 

Q-swich/D-A
To Laser 
Driver

Fire Camera

Fire 

Calibration Lamp

Cal. Fiber

Appendix 1
LIB Spectra Connections II 
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a) Disposable gloves 
b) Acetone 
c) Lint-free paper wipes.

Appendix 2
Cleaning of LIBspector optics I

General Notice : Always keep the protective windows clean to avoid possible 
damage from the applied LIBS laser radiation

Step 0: Required aids for cleaning the 
protective window

Step 1: Remove protective window

a. Open the from door of the LIBSSprctor
b. Turn the magnetic holder counterclockwise
c. Remove the magnetic holder from the housing 
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Appendix 2
Cleaning of LIBspector optics II
Step 2: Cleaning protective window

d. Remove protective window from 
the holder. Observe the two 
sealing rings 

e. Clean the protective window with 
acetone and tissue wipers. 

Step 3: Mounting protective window.

f. Place the clean protective windows 
between two sealing rings inside holder

g. Turn the magnetic holder clockwise to 
mount the holder

h. Close the front door
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